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Temporay Operating Instructions 

 
This is a temporary version of the operating instructions to get you started. 
 
When you start a new document based on one of my templates, you first get a group of small dialogue boxes, 
which describe how you don’t have to pay me the main fee for use of the templates, until you succeed in 
selling a major script. However when you make your first sale, I will expect a small cut from it, and then you 
have free use forever after. These boxes look like this: 
 

 
 

 
Scroll through to read this note, then click on [CONTINUE], this won't happen every time you open your 
script to work on it, only each time you start a whole new script. 
 

PDF created with FinePrint pdfFactory trial version http://www.pdffactory.com

http://www.pdffactory.com


 

________________________________________________________________________  
Page 2                                                                                                             21-Aug-03 

252 Colney Hatch Lane, London N10 1BD,  
Phone: 020-8444 6706.   Fax: 020-8444 7968. 

e-mail: billwill@datahighways.co.uk 
 

After the adverts, you reach a dialogue box, into which you type the name of your new masterpiece; this can 
be a working title, as you can change it later. 
 

 
--  Microsoft Word: BillWill's Script Templates   
     
  Enter Title of Script   
     
 Title  of Script   
     
 OK  Cancel  
     

 
 
 
After you type in your title and do an OK, the Characters ' Names box appears. 

 
-- Microsoft Word: BillWill's Script Templates 

Please Enter the names of the characters in your script. 
      

Person 1   Person 11   
Person 2   Person 12   
Person 3   Person 13   
Person 4   Person 14   
Person 5   Person 15   
Person 6   Person 16   
Person 7   Person 17   
Person 8   Person 18   
Person 9   Person 19   

Person 10   Person 20   
      
 Use TAB or Mouse clicks to move from person to person OK  Cance

l 
 

 Should you need more than 20 characters in your script, you can type infrequent names 
 each time they speak 
      
 
You work down this box putting in the working names of your characters for your play; they don't have to be 
the final names as you can change them later.  As you can see from the on-screen notes, you move from field 
to field above using the Tab key or the mouse, (Shift+Tab will move backwards).Each of these 20 entries 
have fast keystrokes to put in the name and be ready to type the dialogue. If your play needs more than 20 
characters, the instructions for typing dialogue for the 21st etc. are detailed later in this document. 
 
When you have typed in the initial set of characters, click the OK button. You will see the names being 
inserted into the crib sheet on the first page of your script. The document will then prompt you to save the 
empty script. You should navigate to the place in your filingsystem on your hard disk whereyou want to save 
it, and give it a relevant name.  
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Print the Crib Sheet 
Your first action should be to print the crib sheet, so that you can have it in front of you while you work. The 
crib sheet is Page 0 of your script, so printing it on its own is done by just selecting File then Print, and then 
select Curent Page and press OK.  
 
The crib sheet shows you the shortcut keystrokes corresponding to the characters in the list, from Control +1 
for the first person through to Control+Shift +0 for the 20th Person.  
 
Below the description of those keystrokes are the short cuts to be used to change the style of a paragraph; 
(most of these also have a button on the toolbar to do the same operation, see diagram below.(the toolbar 
varies slightly according to the needs of particular templates.. 
 

 
If you cannot see the toolbar you will need to drop down the View menu, select Toolbars and put an X in the 
Scripts line to see this button bar; you could also clear the other Xs because with all the built-in script 
formatting you are unlikely to need the normal formatting toolbars. You can also turn off the Ruler in the 
View menu as you wont need that either. 
 
As you use the templates you will see that the various type of the paragraphs are shown in different colours, 
so that you can easily tell that they have been set correctly. They will print in ordinary black and white  of 
course, though if you have a colour printer you may need to instruct it to print in black & white. 
 
You next action can be to revise the various bits of personal information on the Title page, but that can be 
left till later. Now while you have the urge to write scripts it is probably best to get into the meat of it. So use 
the PgDn key or the right-hand scroll bar controls to get to the beginning of the main script.  
 

Scene Start 
Place your mouse cursor on the first slug line, (usually called SCENE 1) and click to move the keyboard 
insertion point to there. Modify the line to suit the first scene of your play and then move down to the second 
line if there is one and modify this too.  Then with the cursor at the end of the line press the RETURN key 
 

First Stage Directions 
The style will then switch to Stage-Directions format and you type in your first set of stage directions.  

Character names and Dialogue 
When you are ready to begin some dialogue don’t hit return at the end of the directions paragraph instead 
press the key combination for the relevant person (e.g. CTRL+1 for Person 1). This keystroke combination 
will finish the current paragraph, go down by the right amount of spacing, insert the Name of the character 
and position the insertion point ready to type dialogue. For Film and Studio scripts this is on the next line, 
for Stage and  Radio scripts it is on the same line. Should you find that you pressed the wrong combination, 
it is easy to just hit the correct combination and then delete the redundant empty name later using the mouse; 
but should you wish to delete an erroneous name immediately, hold down shift and use the arrows to 
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highlight it backwards, then press the DEL key. (If you backspace one position too many the previous 
dialogue will become NAME type, so just press CTRL+SHIFT+D to switch it back to dialogue, or click the 
chat balloon button on the toolbar). 
 
When you have finished the dialogue of the current speaker, don’t press RETURN, just press the key 
combination for the next speaker; it will do the details for you and position the insertion point ready for you 
to type dialogue. 
 

More stage directions 
To switch from dialogue to more stage directions, press Return then CTRL+SHIFT+V to switch style to 
directions and carry on typing. To start dialogue again, just press the key combination of the next speaker. 
 

At the end of a scene 
Studio Film Stage Radio 
Press RETURN, type 
Cut-to or Fade-to etc. 
and press 
CTRL+SHIFT+C. 
Then press 
CTRL+SHIFT+E or 
CTRL+SHIFT+I and 
finish the scene heading 
etc.  
 
The template will force a 
page break, after the Cut-
To 

Press RETURN, press 
CTRL+SHIFT+I (for 
scene heading) or 
CTRL+SHIFT+E for the 
INT or EXT scene 
heading as relevant, then 
type the rest of the slug 
line. 
Scenes in films can be 
very short, so only a few 
blank lines, not a page 
break are used to 
separate scenes. 
Films have only one slug 
line per scene, when you 
press RETURN you are 
ready to type the first 
Directions. 

Press RETURN, press 
CTRL+SHIFT+E and 
type e.g. End of Scene 1, 
Press CTRL+SHIFT+S 
and type the heading for 
Scene 2. 
 --------------------------- 
For a new Act after 
ending the Scene, press 
RETURN then 
CTRL+SHIFT+Z then 
press CTRL+SHIFT+A 
and type 
CTRL+SHIFT+S: etc. 
 
The template causes each 
Act to begin on a new 
page. 

Radio plays don’t have 
scenes, just keep 
alternating dialogue and 
sound effects until the 
play is finished. The 
final END is already in 
place. 

 
 

Typing Names for Infrequently Speaking Characters. 
The shortcut keystrokes cover 20 speaking characters, if you have more than 20 in your play, assign the most 
frequent speakers to the 20 shortcuts. For the others you type their names each time they speak with a few 
extra keystrokes to set the styles.   
 
Film and Studio Scripts Stage and Radio Scripts. 
At the end of the previous speakers dialogue (or 
stage directions), press RETURN, then press 
CTRL+SHIFT+N to set Name style, then type the 
name of the character e.g. The Vicar and press 
RETURN 
 
Then you can type his dialogue. 

At the end of the previous speakers dialogue (or 
stage directions), press RETURN then 
CTRL+SHIFT+N to select Name style, then TAB 
then type the name of the character, e.g. The Vicar 
then COLON then TAB. 
 
You can then type his dialogue 
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Parenthesis 
Sometimes you will want to put various qualifiers against a persons name such as OOV for out of view or 
(continued) for the same speaker talking after some stage directions or a page break. You can either put this 
on a line by itself usually in round brackets and press CTRL+SHIPT+P or type it at the relevant point in the 
dialogue in brackets. If you then come back to it in an editing pass, highlight the qualifier with the mouse 
and click the Pin-button on the toolbar; it will then put just that highlighted portion into italics. 
 
Sometimes this is used to indicate moods e.g. (angrily) though I see from some Internet notes that you are 
advised not to do this in dialogue, but to set the mood correctly in the Stage Directions preceding the 
dialogue. 
 

Poetry and Blank Verse 
The Stage and Radio Templates contain styles for Poetry or Blank Verse, this is set by the Blank button on 
the toolbar or by pressing CTRL+SHIFT+Y. In the present versions this does not set the style correctly on 
the line with the name on it, so you will need to press RETURN after the name then CTRL+SHIFT+Y to 
start the poetry. 
 

Non-printing notes 
There is a facility for including non-printing notes in your script, CTRL+SHIFT+U will start these notes, or 
you can drop down the style list and select non-print style. These notes are displayed in grey font. 
 

Revisions 
As you go through a script to revise it, you will sometimes accidentally delete the invisible paragraph mark 
at the end of a paragraph, causing its style to change to the wrong one. Simply click the mouse in the 
paragraph to put the insertion point in the paragraph an then click the relevant button on the toolbar to reset 
the paragraph type. You might lose the characteristic blue colour, but this is not important. 
 
If you decide to rename any of the characters or to use up a few more of the 20 names, click on the Smiley 
button  to bring up the Characters' Names box. When you have made your  alterations click OK. The 
revisions will then be inserted in the crib sheet and from there will propagate into the Names headers in the 
script. The names in dialogue or stage directions will not be revised; to change those use the Edit menu, then 
the Replace option. 
 
The Character’s Names are actually held as invisible document variable, but the crib sheet must not be 
deleted after printing it, or it will cause an error when you update the character list 
 
When revising  just before printing you may find that you need to insert a page break. On the Film template 
is a button with a page-split on it which inserts a page break with the (continued) markers  You will need to 
insert the speakers Name again with his/her shortcut keycode and then put (continued) and use the 
parenthesis button on it. Should you subsequently decide to remove that page break, first switch the view to 
Normal mode so that it is easy to highlight and delete the whole pagebreak sequence. Practice it first before 
using it on a serious script. 
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Passing the Script to the Production Team 
 
As before mentioned if you pass a script on floppy disk or by modem to a colleague, then they will not be 
able to use the full automatic features unless you also pass them a copy of the template. Production teams 
probably don’t need the full facilities, so to make a submission script drop down the Format menu and select 
the bottom entry which reads "Make Submission Script" or "Make Production Script".Then click OK on the 
messageswhich appear. 
 
This action, changes all the colours to black, then removes the cribsheet, then disconnects the template to 
remove the macros. This prevents a macro virus security alert from occurring in the production office. The 
result is a plain Microsoft Word document which looks as if it has been typed by an expert user of Word, 
with full understanding of paragraph styles. 
 
 

Copyright 
 
The copyright in any scripts which you write belong to your usual copyright holder, usually yourself unless 
you are writing under contract for someone else, but the copyright in the templates themselves is mine, so 
you may not modify the templates and sell or pass them as a scripting system to anyone else, without 
permission and a suitable fee. 
 

Further Information 
 
This is the fifth release of these templates and this documentation, further revisions will be produced in due 
course, together with an example script done with each template. 
 

Bill Williams 
21 August, 2003 
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